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1.0 GENERAL DESCRIPTION
1.1 Introduction

HV650QUB-FIL is a color active matrix TFT LCD open cell using amorphous silicon TFT's
(Thin Film Transistors) as an active switching devices. This module has a 64.5 inch
diagonally measured active area with UHD resolutions (3840 horizontal by 2160"vertical
pixel array). Each pixel is divided into RED, GREEN, BLUE dots which are arranged in Z-
inversion stripe and this module can display 1.07G colors. The TFT-LCD panel used for

this module is adapted for a low reflection and higher color type.

RGB (CEDS)
- Source Driver Circuit
VDD S1 S3840
—_—
+12.0V
Vbyone | CN1 Timing Controller
—_—
8 lanes (51pin) > [V by one Rx & CEDS
Tx integrated]
HTPDN | TFT - LCD Panel
LOCKN T (3840 x RGB x 2160 pixels)
— v
Power Circuit
Block

1.2 Features

® V by one interface with,8 lanes

® High-speed response

® Low color shift image quality

® 3-bit + ERC/color depth, display 1.07G colors

® Highluminance and contrast ratio, low reflection and wide viewing
® Gate driver use GOA mode

® DE (Data Enable) only mode

® ADS technology is applied for high display quality

® ROHS compliant

® We didn’t use substances and uses prohibited in  {SS-00259 for general use)

angle
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1.3 Application
® Home Alone Multimedia TFT-LCD TV only
® Ultra High Definition TV(UHD TV)
® Display Terminals for Control System, Public Monitor and etc... are not allowed
1.4 General Specification
< Table 1. General Specifications >
Parameter Specification Unit Remark
OC Size 1440.48(H) x 817.02(V) x 1.32(D) mm H&V+0.2/D+0.1
Active area 1428.48(H) x 803.52(V) mm
Number of pixels 3840(H) x2160(V) pixels
Pixel pitch 372(H) x372(V) um
Pixel arrangement Pixels RGB.Z-inversion stripe -
Display colors 1.07G(8bits + FRC)) colors
Display mode Transmission mode, Normally Black
Open Cell 0 0 At center point
Transmittance 5-1%(TYP) & with BOE BLU
Weight 3500 gram
Power Consumption 9.86 Watt With TCON
board
Front Polarizer : Haze 1%, 3H,
Surface Treatment Semi-glare or Anti-glare treatment -
Bottom Polarizer : Clear
Protection Film Measured by JIS
Peeling Force 20(Max) gf/25mm Z 0327
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2.0 ABSOLUTE MAXIMUM RATINGS

The followings are maximum values which, if exceed, may cause faulty operation or
damage to the unit. The operational and non-operational maximum values are listed in the

below table.
< Table 2. Open Cell Absolute Maximum Ratings >
[VSSEGND=0V]
Parameter Symbol Min. Max. Unit Remark
Power Supply Voltage VDD VSS-0.3 +13.5 V. Taz25°C
a=
CMOS/TTL Input Voltage DVDD VSS-0.3 +3.6 V
. Top 0 +50 °C
Operating Temperature
Tsur 0 +65 °C
Storag-e Tempe-rature Tsr -20 +60 C Note 1
Oper_at_lng Ambient Hop 10 90 %RH
Humidity
Storage Humidity Hst 5 90 %RH
Note 1: Temperature and relative humidity range are shown in the figure below.
Wet bulb temperature should be 39 °C-max.’and no condensation of water.
90%
Y
/ Va “0%
./-; /’! ’ 70 + =
5 / / // — Storage
Wet Bulb / y / §
Temperature°C] /A J/ )
a0,/ =
4 40% 2>
e o he Operation
: 7
- 100""0
Dry Bulb Temperature [*C]
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3.0 ELECTRICAL SPECIFICATIONS

3.1 TFT LCD Open Cell

< Table 3. Open Cell Electrical Specifications >

[Ta=25+2 °C]

Values :
Parameter Symbol : Unit [.Remark
Min Typ Max
Power Supply Input Voltage VDD 10.8 12 13.2 \%
Power Supply Ripple Voltage VRP - - 600 mV
Power Supply Current IDD - 0.83 2.58 A Note 1
Power Consumption PDD - 9.86 31 Watt
Rush current IRUSH - - 10 A Note 2
Differential Input High
Threshold Voltage VLVTH +50 mv
V by One | Differential Input Low i i i
Interface | Threshold Voltage VLVTL R mv
Common Input Voltage VLVC - - - \%
Terminating Resistor Rt 90 100 110 ohm
Transmission Line
CEDS Impedance 25 i 50 i ohm
Interface - : ,
Input termination Resistance Ri 90 100 110 ohm
Input High Threshold VIH 27 i 33 Vv
CMOS Voltage
Interface | Input Low Threshold
VIL 0 - 0.6 Vv
Voltage

Note 1: The supply voltage is-measured and specified at the interface connector of LCM.
The current draw and.power consumption specified is for VDD=12.0V.
Frame rate f,= 60Hz and Clock frequency = 74.25MHz.
Test Pattern of power supply current.

a) Typ.“\Mosaic 7X5 (LO/L255) b) Max : Horizontal 1 Line (LO/L255) c) Flicker Test Pattern

R G
R G
R G
R G
R G
R G
R G
R G

2: The duration of rush current is about 2m

(7]

R|G|B (€] R|IG|B (€]
+1-1+ + +] -1+ +
G RIG|B (€] RIG|B
+ +] -1+ + +] -1+
RIG|B (€] R|IG|B (€]
+] -1+ + +| -1+ +
G RIG|B (€] RIG|B
+ +]-1+ + +] -1+

and rising time of power input is 1ms(min)
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3.2 Temperature Characteristics
< Table 4. Temperature Characteristics >
Values .
Parameter Symbol : Unit JRemark
Min Typ Max
Driver Surface Temperature Tos - - 125 °C Notel
TCON Surface Temperature T1s - - 100 °C Note2
PMIC Surface Temperature Tos - - 100 °C Note3
Note 1. Any point on the driver surface must be less than 125 °C under,any conditions.
2. Any point on the TCON surface must be less than 100 °C under any conditions.
3. Any point on the PMIC surface must be less than 100 °CG.under‘any conditions.
4. This test condition is based on BOE module.
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other.

2. Adjust PVCOM Flow Chart

3.3 VCOM 12C Bus Format and interval setting requirement

1. Initialize (Hardware/Software) Setting and correctly communicate with each

| START \.:'
¢ -
T h J
e H <} N
H..--""-';r'ezk HW and SW is ™~ Step 2 P
ok? i Adjust VCOM value |
. T )
Yes i
Switching to Flicker ey ._l- e Flebar e R .f: C Flicker i OK? S
Pattern 1ivig _:.h.-.l» icker is \.Kl.}‘._ — ".""'-x:jﬂ licker is O .»'—
| ~.,__H]’__,
es pl
v -
Ctep 3 *B(0m
Stepl \ WCOM into P
Read VCOM value 'y .J:?: .
Note 1:
Fogister | Address Bit? Bits Bits B4 B Bitz Birt Bitg
VCOM 15 WCOME 0f
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3.3 VCOM 12C Bus Format and interval setting requirement
3. Stepl: Read VCOM
Slave Address I Control Register I nstruction
5 (Ob010D0000) (Ob11111111) (DB000D00001)
[0x40) |OxFF) {0x01)
| I et I e g
[0 [0x15) (L
4. Step 2 Adjust VCOM Value
Slave Address I Register Address I Data form Master
(0bO1000000) {0b00010101) (Obsooooooc) B P
[ D30 ) (0x15) (0?7 )@ reglsh
5. Step 3 Write VOCM Value into NVM
Slave Address I Control Register I Dafa Sl i3ster
5 (Ob11111111) (90 1B00000) P
{OxFF) 10wa0)
Note 2:
s start
|E|: stop
I: ack form slave(iML8970)
;: ack form master
NA
__I: noack
sr
L_I: repeated start
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4.0 INTERFACE CONNECTION

4.1 V-by-One input connector pin configuration
- 51pin Connector: 05030WR-H51B(NC)

< Table 5. 51-Pin V-by-One Input Connector CN1 Pin Configuration>

Pin No|[ Symbol Description Pin No| Symbol Description

1 VDD Power Supply +12.0V 27 GND Ground
2 VDD Power Supply +12.0V 28 Rx0n V-by-One HS Data Lane 0
3 VDD Power Supply +12.0V 29 Rx0p V-by-One HS Data Lane 0
4 VDD Power Supply +12.0V 30 GND Ground
5 VDD Power Supply +12.0V 31 Rx1n V-by-One HS Data Lane 1
6 VDD Power Supply +12.0V 32 Rx1p V-by-One HS Data Lane 1
7 VDD Power Supply +12.0V 33 GND Ground
8 VDD Power Supply +12.0V 34 Rx2n V-by-One HS Data Lane 2
9 NC No Connection 35 Rx2p V-by-One HS Data Lane 2
10 GND Ground 36 GND Ground
11 GND Ground 37 Rx3n V-by-One HS Data Lane 3
12 GND Ground 38 Rx3p V-by-One HS Data Lane 3
13 GND Ground 39 GND Ground
14 NC No Connection 40 Rx4n V-by-One HS Data Lane 4
15 NC No Connection 41 Rx4p V-by-One HS Data Lane 4
16 NC No Connection 42 GND Ground
17 NC No~€onnection 43 Rx5n V-by-One HS Data Lane 5
18 SDA Tcon SDA IN 44 RX5p V-by-One HS Data Lane 5
19 SCL Tcon SCL IN 45 GND Ground
20 | nwp H: Write Enable 46 | Rxén | V-by-One HS DataLane 6

L&NC: Write Disable
21 NC No Connection 47 Rx6p V-by-One HS Data Lane 6
22 NC No Connection 48 GND Ground

Valid VBO input :

_ L&H&NC: Normal display
23 ﬁ/l?)lgg Invalid VBO input : 49 Rx7n V-by-One HS Data Lane 7
L: Black pattern;

H&NC: Aging pattern
24 GND Ground 50 Rx7p V-by-One HS Data Lane 7
25 HTPDN Hot plug detec 51 GND Ground
26 LOCKN Lock detect
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Notes :

1. NC (Not Connected) : These pins show status of T/con board and are only used for BOE internal operations.

2. Input pins assignments on T/con board refer to the below diagram.

CN1

1 [r||||||||||||||||||||||||||||1]51
| | | |

3. If T/con board can’t receive correct V-by-One signals, T/con will run BIST pattern‘as bellow.

PT1:Black PT2:White PT3:Red PT4:Green PT5:Blue
(2 sec) (2 sec) (2 sec) (2'sec) (2 sec)

4, Circuit Block Diagram pin of SDA/SCL on T/con hoard..They are used for flicker adjustment only.

DVDD +3.3V DVDD +3.3V
e ~
3 <
Pin 18 : SDA
Switch IC 1 VCOM IC
PinA19 : SCL (nWPH:O
/L: OFF )
Pin.20 : NWP
=
GND
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Notes :
5. Circuit Block Diagram of HTPDN/LOCKN/Aging Mode on T/con board.
DVDD +3.3V
1] o]
Pin 25 : HTPDN =————9
499R
Pin 26 : LOCKN L '_'ll
TCON IC
Pin 23 : Aging Mode @
g
GND
SPEC. NUMBER SPEC. TITLE PAGE
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4.2 V by One Data Mapping Setting

< Table 6. V By One Mapping Diagram >

In— 1 N
<
90‘
Q
\\f)

’\Q, Connector V-by-One
CN1 Lane O — Lane 7
SPEC. NUMBER SPEC. TITLE PAGE
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4.2 V by One Data Mapping Setting
< Table 7. V By One Data Mapping Setting Table >
1 Section
Area - Input Data Stream
1st 2nd | ... 480th
Lane O Pixel 1 Pixel9 | ... Pixel 3833
Lane 1 Pixel 2 Pixel10 |  ...... Pixel 3834
Lane 2 Pixel 3 Pixel11 |  ..(= Pixel 3835
Lane 3 Pixel 4 Pixel 12 | _....... Pixel 3836
ATB Lane 4 Pixel 5 Pixel 13 « [~ ...... Pixel 3837
Lane 5 Pixel 6 Pixel 14 ~  ...... Pixel 3838
Lane 6 Pixel 7 Pixel 15 |  ...... Pixel 3839
Lane 7 Pixel 8 Pixel16 |  ...... Pixel 3840
2. Section
Input Data Stream
Area ~ane 1st 2nd | ... 480th
Lane O Pixel 1 Pixel5 | ... Pixel 1917
Lane 1 Pixel 2 Pixel6 |  ...... Pixel 1918
A Lane 2 Pixel 3 Pixel7 |  ...... Pixel 1919
Lane 3 Pixel 4 Pixel8 | ...... Pixel 1920
Lane 4 Pixel 1921 | Pixel 1925 |  ...... Pixel 3837
Lane 5 Pixel 1922 | Pixel 1926 |  ...... Pixel 3838
° Lane 6 Pixel 1923 | Pixel 1927 |  ...... Pixel 3839
Lane 7 Pixel 1924 | Pixel 1928 |  ...... Pixel 3840
Note: T/con board supports two kinds of sections. System board output can choose either of them.
SPEC. NUMBER SPEC. TITLE PAGE
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4.0 INTERFACE CONNECTION
4.3 TCON Board Input Connector & FFC Drawing
-51pin Connector Drawing-05030WR-H51B(NC)
Aﬂ.ﬂ
1 5tu.l BQJS
No.1 P3Q.5:e Q2w LA i
- -
- .IEQIH JL ! L] pupoannneang 1 L] "
[ T T ] i ':33
ui =y 7 3
U 0 H H u) 5
e
3&0.! DiN E:HH
(PITCH) (PITCH)
Cta.l.'o
H:NI.!E
1
v A
N A4 o2 rd
2
0.5% | = —
SEC A—A 0.6: m 0.7:
(SCALE 10:1)
NO. OF POS. PARTS NO. A B C D E F G H
o1 05030WR-H51B 31.0 | 25.0(35.35] 5 S 135.95]34.75]38.00
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4.0 INTERFACE CONNECTION
4.4 TCON Board Output Connector & FFC Drawing
-68pin Connector Drawing-FC0568-L3920W420H180-N03
=) 38.10
9 33.50
b _..0.20+0.03

A=

SseoppaaoeoppNNeagn

[RRR;RERRRRR;QHHH
/

1.78
f=

A NG w;\\\\/
() }g R A \\\&

—10.10]

é&i&'@/ TERMINAL

3.90
.10
FFC Stoper
(o)
S
i
(1.10 !
1.40 0.50

SECTION A-A
SCALE 2:1

Note: XPCB bhoard input connector is the same as T/con board output connector.
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4.4 TCON Board Output Connector & FFC Drawing
-68pin FFC Drawing

55.8%0.1 35:8%£0.1
33.50+0.05 _33.50+0.05 _
0.50£0.05 1.15+0.05 1 .. 0.50+0.05 1NB+0.05
[0.350.05 [ [0.30+0.03 ‘
| J I | i e
VANV V7 1A% % 7V %
i 1oy k 7 a0
= VN2V 7
= ¢/,gg ) ? ?% =z m V7 AN £
%gésdéé/ = AN AN s
| / T9] | l wn
RECOMMENDED FFC DIM. RECOMMENDED FPC/FFC DIM.
[HICKNESS:0.5+0.03 [HICKNESS:0.3+0.03
Notes: This FFC drawing is supplied by the connector vendor. It is for reference only.
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5.0 INTERFACE SIGNAL TIMING SPECIFICATION
5.1 V by One signal specification
- Vx1 Byte length and Color mapping
. Color data mapping
Byte Packer input 30 bpp RGB
Bit-0 R2
Bit-1 R3
Bit-2 R4
0 Bit-3 RS
Bit-4 R6
Bit-5 R7
Bit-6 R8
Bit-7 R9
Bit-8 G2
Bit-9 G3
Bit-10 G4
1 Bit-11 G5
Bit-12 G6
Bit-13 G7
Bit-14 G8
Bit-15 G9
Bit-16 B2
Bit-17 B3
Bit-18 B4
5 Bit-19 B5
Bit-20 B6
Bit-21 B7
Bit-22 B8
Bit-23 B9
Bit-24 -
Bit-25 -
Bit-26 BO
3 Bit-27 Bl
Bit-28 GO
Bit-29 Gl
Bit-30 RO
Bit-31 R1
SPEC.NUMBER | SPEC. TITLE PAGE
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5.0 INTERFACE SIGNAL TIMING SPECIFICATION
5.2 V by One Input Signal Timing
< Table 8. Signal Timing Table >
Parameter Symbol Condition Min Typ Max | Unit
_ _ 3byte mode 266 tTCIP/30 | 1667 | PS
Unit '”ter";'t(\éig)or’era“on {RBIT | 4byte mode | 266 | {TCIP/40 | 1667 | PS
5byte mode 266 tTCIP/50 | 1667 | PS
Eye Width at Package Pin tREYE - - 0.5 - ul
Eye Width Posm_on Aat A i i 095 i Ul
Package Pin
Eye Width P05|t|pn B at B i i 03 i Ul
Package Pin
Eye Width Posm_on Cat i i i 0.7 ) Ul
Package Pin
Eye Width P05|t|pn D at D 3 i 0.75 ) Ul
Package Pin
Eye Width P03|t|pn E at £ i i 0.7 ) Ul
Package Pin
Eye Width P03|t|pn F at {F i i 03 ] Ul
Package Pin
Intra — pair Skew tRISK _intra - - - 0.3 Ul
Inter — pair Skew tRISK inter - - - 40 ul
SSCG i 30KHz 1 5 : +05 | %
modulation
tRBIT
Y[mV]
\ 5 c A 0
A D Y-0 mvV B 50
/ c 50
F E
D 0
E -50
tREYE F -50
X=0 Ul X=1 Ul
SPEC. NUMBER SPEC. TITLE PAGE
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5.0 INTERFACE SIGNAL TIMING SPECIFICATION
5.3 Signal Timing Parameters
< Table 9. Timing Table >
Item Symbols Min Typ Max Unit
Pixel Clock Frequency 1/Tc 69 74.25 75 MHz
Frame Rate F 47 60(50) 61 Hz
Total Ty 2200 2250(2700) 2850 Ty
Vertical Display Tvp 2160 Ty
Blank Tys 40 90(540) 690 Ty
Total Ty 530 550 570 Tk
Horizontal Display Tuo 480 Tek
Blank Ths 50 70 90 Tk
Item Symbols Min Typ Max Unit
Pixel Clock Frequency 1/7c 69 74.25 75 MHz
Frame Rate F 47 48 61 Hz
Total Ty 2200 2816 2850 Ty
Vertical Display Tvp 2160 Ty
Blank Tyg 40 656 690 Ty
Total Ty 530 550 570 Teik
Horizontal Display Tup 480 Tek
Blank Ths 50 70 90 Teik
Notes:
1.This product is DE only mode. The input of Hsync & Vsync signal does not have an effect on normal
operation.
2. This product should keep clock frequency and Horizontal value fixed when adjusting frame rate.
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5.4 Input Signals, Basic Display Colors and Gray Scale of Colors

< Table 10. Input Signal and Display Color Table >
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5.5 Power Sequence

In order to get a normal display of the Open Cell, the power on/off sequence shall be as
shown in below.

0.9vDD H# o
Power Supply 0.1VDD 0.1v0D
VDD ov <
T1 T T2
- " T5
LOCKN
ov
Interface Signal CTR Data
(Input Data )
T3 T4
BLU ON/OFF enable
( VON/OFF)
T7
nwp D v
ov
< Table 11. Sequence Table >
Values _
Parameter i v — Units

11 0.5 - 10 o
12 0 - 500 ms
T3 T2 _ i -
T4 100 } - s
T5 0 i i o
T6 1 _ i S
T7 T3 _ i -

Notes: 4. Even though T1 is out of SPEC, it is still ok if the inrush current of VDD is below the limit.

2. Back Light enable must after power ready for logic and interface signal are valid.

3. All input signals should set to 0 volt before VDD rising edge ready.

4. If possible, T3 should not less than hundreds of milliseconds, so do T2.

5. nWP pull high should be after BLU enable. Avoid conflicts when SOC and Tcon use the same IIC
channel at the same time.

6. VDD should rise and fall smoothly. If there is rebounding voltage when falling stage, it must smaller

than 5 volts.
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6.0 OPTICAL SPECIFICATION

The test of optical specifications shall be measured in a dark room (ambient luminance<1 lux
and temperature=25+2°C) with the equipment of Luminance meter system (Goniometer
system and PR730) and test unit shall be located at an approximate distance 180cm from
the LCD surface at a viewing angle of 6 and ® equal to 0°. We refer to 84, (=65 ) as the 3
o’clock direction (the “right”), 64-9o (= 6,5 ) as the 12 o’clock direction (“‘upward”), 85-159 (= 69 )
as the 9 o’clock direction (“left”) and 84-,,0(= 65) as the 6 o’clock direction (“bottom”). While
scanning 8 and/or @, the center of the measuring spot on the Display surface shall stay fixed.
The measurement shall be executed after 30 minutes warm-up period. VDD shall be 12.0V
+/-10% at 25°C. Optimum viewing angle direction is 6 'clock.

< Table 12. Optical Table >
[VDD = 12.0V; Frame rate = 60Hz, Ta =25+2 °C]

Parameter Symbol [ Condition | Min Typ Max | Unit | Remark
Horizontal O, - 89 - Deg.
fawi orizonta
Viewing o, ] 89 i Deg.
Angle CR>10 Notel
. 612 - 89 - Deg
Vertical
CH - 89 - Deg.
Contrast ratio CR 900:1 [1200:1 - Note2
w 0.279
White -
W, 0.308
Red R, O=0° 0.636
Reproduction R, (Centen) | tvp 0333 | TYP
of color G '\'.OW‘a' -0.03 [ 9299 | +0.03 Note3
Green X Viewing .
G, Angle 0.619
B, 0.154
Blue
B, 0.060
Response Time| Gto G T, - 8 10 ms Note4
Cell Transmittance 4.59 5.1 - % Note5
Gamma Scale 2.0 2.2 2.4
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Notes :

1. Viewing angle is the angle at which the contrast ratio is greater than 10. The viewing are

determined for the horizontal or 3, 9 o’clock direction and the vertical or 6, 12 o’clock
direction with respect to the optical axis which is normal to the LCD surface.

. Contrast measurements shall be made at viewing angle of 6= 0° and at the center of the LCD

surface. Luminance shall be measured with all pixels in the view field set first to~white, then
to the dark (black) state. (See Figure 1 shown in Appendix) Luminance Contrast-Ratio (CR)
is defined mathematically.

Luminance when displaying a white raster

R =
c Luminance when displaying a black raster

. The color chromaticity coordinates specified in this table shall'be calculated from the spectral

data measured with all pixels first in red, green, blue . and white. Measurements shall be
made at the center of the panel. The chromaticity coordinates are based on BOE backlight.

. Response time Tg is the average time required for display transition by switching the input

signal as below table and is based on Frame rate fV = 60Hz with BOE Tcon Board to
optimize. Each time in below table shall be measured by switching the input signal for “any
level of gray(bright)’and “any level of gray(dark)”

Response
Time

Measured Target

o 15 21 47 632 g 8BS 111 127 1432 158 175 1891 207 ZZ2 28 255

Start

o

15

31

a7

63

111

127

142

158

173

121

o
ZFZ3
238

G

5. Definition of Transmittance (T%) :

Module is with white(L255) signal input

Luminance of LCD Module
Transmittance = x 100 %
Luminance of BLU
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7.0 RELIABILITY TEST
The Reliability test items and its conditions are shown in below.
< Table 13. Reliability Test Parameters >
No Test Items Conditions
1 | High temperature storage test Ta =60 °C, 240 hrs
2 | Low temperature storage test Ta =-20 °C, 240 hrs
3 | High temperature & high Ta = 50 °C, 80%RH, 240hts
humidity operation test
4 | High temperature operation test | Ta = 50 °C, 240hrs
5 | Low temperature operation test | Ta = -5 °C, 240hrs
6 | Thermal shock Ta =-20.°C < 60 °C (0.5 hr), 100 cycle
7 | Open cell vibration test 1.05G,5-200Hz,Random,+Z,1Hour
Note : Test condition is based on BOE module.
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8.0 PRECAUTIONS
Please pay attention to the followings when you use this TFT LCD Open Cell.

8.1 Precautions when taking out the Panel
» Pick the pouch only, when taking out panel from a shipping package.
* Recommend to use suitable sucker to pick up and put down panel.

8.2 Precautions for handling the panel

» As the electrostatic discharges may break the LCD panel, handle the LCD panel with care.
Peel a protection sheet off from the LCD panel surface as slowly as possible. Refer to the
appendix 3.

» As the LCD panel and backlight element are made from fragile glass material, impulse and
pressure to the LCD panel should be avoided.

» As the surface of the polarizer is very soft and easily, seratched, use a soft dry cloth without
chemicals for cleaning.

» Put the panel display side down on a flat horizontal plane.

+ Handle connectors and cables with care.

8.3 Precautions for the operation

* The LCD product shall be operated under normal conditions as below:
- VDD: 12+0.12V
- Temperature: 20£15°C
- Humidity: 55£20%

- Display pattern: continually changing pattern(Not stationary)

* Product reliability and. functions are only guaranteed when the product is used under right
operation usages. Ifsproduct will be used in extreme conditions such as high temperature,
high humidity, high altitude, special display patterns, long time operation, outdoor operation,
etc.., it is strongly recommended to contact BOE for the advice about the application of
engineering. Otherwise its reliability and function may not be guaranteed. Extreme conditions
are commonly found at airports, transit stations, banks, stock markets, and controlling
systems.

* Do not exceed the absolute maximum rating value.

» Periodical power-off or screen save is needed after long-term display.

SPEC. NUMBER SPEC. TITLE PAGE
S8-64-AA-288 HV650QUB-FIL Product Specification 27 OF 40
DAS-RD-2020014-A A4(210 X 297)




B O E PRODUCT GROUP REV ISSUE DATE

TFT- LCD PRODUCT Rev.O 2022.09.27

8.0 PRECAUTIONS

» Do not insert or pull out the interface connector while the LCD panel is operating.

* LCD Response time depends on the temperature.(In lower temperature, it becomes longer)

* Ensure all input signals and power supplies are complete and valid when the panel is
operating. Otherwise the LCD panel would be damaged.

+ Obey the supply voltage sequence. If wrong sequence is applied, the panel ‘would be
damaged. Specially, pay attention to the turn on and off sequence.

8.4 Precautions for the atmosphere
+ Recommend storage atmosphere

ITEM UNIT MIN MAX
Storage °
Temperature () ° 40
Storage Humidity (%RH) 35 75
Storage Life 6 months

» The storage room should be equipped with a dark and
good ventilation facility.

* Prevent products/from being exposed to the direct sunlight,
moisture and-water.

« The produet need to keep away from organic solvent and
corrosive,gas.

« Be careful for condensation at sudden temperature change.

+ Storage condition is guaranteed under packing conditions.

Storage Condition

» Dew drop atmosphere should be avoided. When expose to drastic fluctuation of temperature
(hot to cold or cold to hot ) , the LCD module may be affected. Specifically, drastic
temperature fluctuation from cold to hot, produces dew on the LCD module ‘s surface which
may affect the operation of the polarizer and LCD module.

Do not ;store-and/or operate the LCD panel in a high temperature and/or humidity
atmosphere. Storage in an electro-conductive polymer packing pouch and under relatively
low temperature atmosphere is recommended.

8.5 Precautions for the panel characteristics

* Do not apply fixed pattern data signal to the LCD panel at product aging.
» Applying fixed pattern for a long time may cause image sticking.
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8.0 PRECAUTIONS
8.6 Other precautions

* In particular in winter, Before putting Panel boxes on the line, aging process is required to
make the temperature of products similar to the temperature of workplace.

» Do not disassemble and/or re-assemble LCD panel.

» Do not re-adjust variable resistor or switch etc.

* Product assembled into module should be stored in the bag(cover case).

» Acetic acid type and chlorine type materials for the cover case are net desirable because the
former generates corrosive gas of attacking the polarizer at high temperature and the latter

causes circuit break by electro-chemical reaction.

» Be careful not to give any extra mechanical stress to the panel when designing the set, and

backlight.

» Do not pull, fold or bend the source COF and the gate COF in any processes.
« If the liquid crystal material leaks from the panel, this should be kept away from the eyes or
mouth. If this contacts to hands, legs, or clothes, you must washed it away with soap

thoroughly and see a doctor for the medical examination.

* When returning the module for repair or_etc., Please pack the module not to be broken. We

recommend to use the original shipping packages.
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9.0 CRITICAL COMPONENT

NO. Printed Wire Board(S-PWB)
1 [Company name SUNTAK MULTILAYE
RPCB COLTD

2 |UL file number E207844

3 [Type designation STM-9

4 Factory identification(if PWB is produced at more than one | |
ocation)

5 |Burning Test classification 94V-0

6 Others marking information as mentioned in individual E-File R 3131'09 BQE
number E207844 = i3

NO. Printed Wire Board(S-PWB)
1 |company name ELEC & ELTEK MULTI
LAYER PCB LTD

2 |UL file number E54926

3 |Type designation E3330HF4

4 Factory identification(if PWB is produced at more than one | |
ocation)

5 |Burning Test classification 94V-0

ELEC-6

6 Others marking information as mentioned in individual E-File ]%4

number 94V-0
£54926 A\
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9.0 CRITICAL COMPONENT

NO. Printed Wire Board(C-PCB)
1 [Company name SUNTAK MULTILAYE
RPCB COLTD

2 |UL file number E207844

3 [Type designation STM-9

4 Factory identification(if PWB is produced at more than one | |
ocation)

5 |Burning Test classification 94V-0

6 Others marking information as mentioned in individual E-File R 3131'09 BQE
number E207844 = i3

NO. Printed Wire Board(C<PCB)
1 |company name ELEC & ELTEK MULTI
LAYER PCB LTD

2 |UL file number E54926

3 |Type designation E3330HF4

4 Factory identification(if PWB is produced at more than one | |
ocation)

5 |Burning Test classification 94V-0

ELEC-6

6 Others marking information as mentioned in individual E-File ]%4

number 94V-0
£54926 A\
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9.0 PRODUCT SERIAL NUMBER

40
@
XXXXXXXXXXX000069
R EanTE X
HV650QUB-FI9K XXXXXX
@ ® @
ltem Size(mm) Remark:
1. MDL ID
Label 40*9 2. FG Code
3. Date
QR code 5.5*5.5 4. OR Code
MDL ID Naming Rule:
Code Digit 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17
code | § [ L] s] o NAdle]3]s]e]as]2]o]ala]o]ol]o
Rl N A R LA L i,
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10.0 PACKING INFORMATION

BOE provides the standard shipping container for customers, unless customer specifies
their packing information. The standard packing method and Barcode information are
shown in below.

10.1 Packing Order

Put EPE pads and panels into the b
ox, 12pcs panels per box and 13pcs Put the box on the pallet,
EPE pads per box

RERREEAR AR A

BOE TECHNOLOGY GROUP CO.,LTD.

Put one Paper cover on the top of boxes ,
pack with wrapping film & belts
Cautions :
When'transferring in warehouse or factory, the arm length of electric forklift or hand pallet tr
uck must be longer than the pallet along the insertion direction.
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10.2 Packing Note
Item Size(mm) Weight(Kg) Material
Desiccant 210*80 0.04 CaCl,
Box 1640(£6)*1090(+5)*128(+1.5) 6.269 EPO
Pallet 1690*1140*137 24 Wood
Pallet Packing 1690*1140*1110 419.561 -
10.3 Box Label
* Label Size : 110 mm (L) x 55 mm (W)
* Contents
Model : HY650QUB-FIL
Q'ty : 12 Open Cell in one box.
Serial No. : Box Serial No. See next page for detail'description.
Date : Packing Date
FG Code : FG Code of Product
_ 110 2 O _
Remark:

HEFEI BOE DISPLAY TECHNOLOGY Co., LTD

1. FG-CODE Number

2. uantity in one box
MoDEL: 00000000000 aty XX @ Q /
e 3. BoxID
sERIAL HO. XI000000R000X @ pare 3000 @ 4. Packing Date
~ 0 DU RN R BOUNHURU AU A A wox @ | (@) NHmber
Total Size:110x55mm
RE ]
Box ID{Naming Rule:
Digit
Code 9 1 2 3 4 5 6 7 8 9 10 11 12 13
Code S L S -] 1 6 3 5 -] 4 2 0 0
Description Products GBN Grade Line Year Meonth | Revision Serial No
Code 00001-ZZZZ7Z7Z
SPEC. NUMBER SPEC. TITLE PAGE
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11.0 APPENDIX 1

12 Q'clock direction
(@=00)

OPTICAL jjzzﬁ? agﬁiﬂ?ckd1rection
STAGE

an'

9 0'clock
direction 812

PR720

v

(@=180)
8 4
I 5] 6(%':%17%c)k direction N~ Ib?gtz:]?:;screen
Ll _. 9o
{L=180cm)
90 Bg -0
< Figure 1. Measurement Set Up >
Any level of gray (Bright) Any level of gray (Dark) Any level of gray (Bright)
3
-1 e b1
-
=
o=
< 2
T o
c o
-8
Q
< Figure 2. Response Time Testing >
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11.0 APPENDIX 2

- =

- T

L = KD

I T I T T T " T E; ﬂm J_%_
i H A [ IR L H H ¥ HEH
i
N
R R R B R ' [ T+l [&[ 0 [F[ [H[ [k
< Figure’3,"\TFT-LCD Open Cell Outline Dimensions (Front View) >
TOLERANCE TABLE(E)
DIMENSION |1 GRADE|2 GRADE|3 GRADE|4 GRADE
L=20 005 0.1] 0.1/ 0.2

20<L=50 | of]o015]| 0.7 |02
50<L=100/0/5] 0.2 [0£5] O/3
100 <L =200| 0.2 |0.25| 0.3 | p.5
200<L 0.25| 0.3 /0.5 /0.8
UNLESS OTHERWISE SPECIFIED
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Peeling Steps:

N o gk~ wbd

11.0 APPENDIX 3

< Figure 4. TFT POL Protect Film Peeling Method >

Peeling direction shows in‘Figure 4.

lonized air should\be blown over during peeling action.

The protection film must not touch drivers and source PCBs.

Be sure to peel off slowly(recommended more than 7sec) and constant speed.
Be sure to ground person with adequate methods such as the anti-static wrist band.

Be sure to ground each source PCB while peeling off the protection film.

If adhesive may remain on the polarizer after the protection film peeling off, please
remave \with isopropyl-alcohol.

Note: COFs and PCBs show product outer contour only in the above diagram. Focus on
the peeling step and ignore the number of COFs and size of PCBs.
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11.0 APPENDIX 4

This product is reverse type display. RGB data mapping scan direction : from left-up to
right-down.

< Figure 5. Display Mode>

Note: COFs and PCBs show product outer contour only in the above diagram. Focus on
the scan direction and ignore the number of COFs and size of PCBs.
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11.0 APPENDIX 5

< Figure 6. EDID Table>

EPH2 65"

M EEPROM(24C256) slave address :AA (1010 1010)

No. Jitem Spec Address Data Remarks

EEPROM data map
00 0102103704005 1060027708/09|0A|0B|oOC]|OD]|OE] OF
00 | F2 | FF | FF | FF | FF | FF | FR. FFE | FF | FE | FF | FF | FF | FF | FF

N BRI AR EEEEREEEEG

w| e || rr| Fe ] Fr FF{?V FF | FF | FE | FF [ FF | FE | FE | FF | FF
E
Fr

30 fF | | FF | FF ;E* FF | FF | FF | FF [ FF | FF | FF | FF | FF
| rr [ Fr| e | Fr|RF | FF | FF [ FF| FF| FF [ FF [ FE [ FF | FF | FF | FF
sol rE | FF [ FF | FE | FF [ FF | FF | FE | FE | FE | FE [ FE [ FF | FE | FF | FF

FF | FF | FF ﬁé FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF

60
70| /| FF gF{ FF | FE | FFE | FF | FE| FE | FF [ FF [ FE | FF | FF | FF
80 | /| FF FF | FE | FF [ FFFE [ FE [ frr | Fr | FE | FF | P | FE | FF
90 | fr | FF | FF | FF | FF [ FF | FF | FF | FF | FF | FF | FF | FF | FF | FF | FF
AD ;é{y FF | FE | FF | FF [ FF | FE | FE | FE | FF | FE | FF | FE | FF | FF
BO FE | FF [ FF | FE | FE [ PR FF | FE [ FR [ FF | FE | PR | FF | FE | FF
colpr [ Fr | Fr | Fr | FF| FF | FF | FF| FF| FF | FF | FF | FF | FF| FE | FF

ol fF [ FF | FE [ FF | FE| FE [ FF [ FF] FF | Fr [ FF [ FE [ FE [ FF | FE | FF

SPEC. NUMBER SPEC. TITLE PAGE
S8-64-AA-288 HV650QUB-FIL Product Specification 39 OF 40
DAS-RD-2020014-A A4(210 X 297)




BOE

PRODUCT GROUP

REV

ISSUE DATE

TFT- LCD PRODUCT

Rev.O

2022.09.27

Declaration of Red Phosphorus Fire Retardants Free

We herewith confirm that the display product delivered by BOE do not

Model Mo : HY&50QUB-FSL

contain Red Phosphorus Fire Retardants.

BOE

ML T

Mo.12 Xihuanzhong Road BDA Beiing, 100

Date 2022.09.27

&, PR. Ehina

Company BOE Technology Group Co. Ltd

Department Quality Systemn Department
E-mail wuxianping@boe.com.cn
Signature

%£3%
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